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FX Tools Software Package - 
FX CommPro N2 User’s Guide 

Introduction 
FX CommPro N2 is part of the FX Tools Pro and FX Tools Express 
software suite. Use FX CommPro N2 to download application software 
to Facility Explorer field controllers and to perform online 
commissioning activities. 

Commissioning refers to a set of processes that ensures the control 
application operates according to the intended specification. 
FX CommPro N2 allows you to test the control application with 
connected Facility Explorer controllers. 

FX CommPro N2 allows you to: 

• read the device status 

• download new control applications 

• upload control applications (FX16 Rev. A and higher only) 

• download new firmware files 

• modify parameters 

• read device-specific data 

FX CommPro N2 uses the same plug-in concept as FX Builder Express. 
With FX CommPro N2, you can also configure and tune the parameters 
in the online mode through an intuitive user interface. 

Note: To communicate with FX CommPro N2, the field controllers 
must have an N2 Open communication card installed. Refer to the 
Facility Explorer documentation for the appropriate controller ordering 
information. 

This document assumes that users are familiar with the N2 Open 
protocol and Microsoft® Windows® operating system. 
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Installation 

Installing FX CommPro N2 Tool 
Windows Operating System Upgrade 

FX CommPro N2 uses the Microsoft .NET Framework; therefore, you 
need to install Microsoft .NET Framework Version 2.0 to run 
FX CommPro N2.  

Upgrade the Windows operating system on your computer before you 
proceed with the tool installation. 

The .NET Framework Version 2.0 
The .NET Framework is a component of the Windows operating system 
used to build and run Windows based applications.  

Checking the .NET Framework Installation 
To check the .NET Framework installation: 

1. From the Start menu, go to the Control Panel. 

2. Double-click Add or Remove Programs. The Add or Remove 
Programs window appears. 

3. Scroll down the list of applications. If Microsoft .NET Framework 
Version 2.0 appears, then the Windows OS upgrade is not 
necessary.  

Getting Microsoft .NET Framework Version 2.0 
To get Microsoft .NET Framework Version 2.0, go to the FX Tools Pro 
CD-ROM. 
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Installing FX CommPro N2 
To install FX CommPro N2: 

1. Close all open programs. 

2. Insert the FX Tools CD-ROM into the CD-ROM drive. The 
FX Tools starts automatically. The CD-ROM Navigator appears 
(Figure 1). 

Note: If FX Tools does not start, select Autorun.exe to start it 
manually. 

 

Figure 1: FX Tools Pro Software Menu 
3. From the Software menu, click FX CommPro N2. The 

FX CommPro N2 Open Setup Wizard appears (Figure 2). 
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Figure 2: FX CommPro Installation Wizard 
4. Click Next. The Select Installation Folder window appears  

(Figure 3). 

 

Figure 3: Select Installation Folder Window 
5. To install FX CommPro N2 in a directory other than the default 

directory shown in the Destination Folder box, click Browse and 
select a different directory. 

6. Select Everyone to install FX CommPro N2 for anyone who uses 
the computer. Select Just me to install FX CommPro N2 for 
yourself. 

7. Click Next. The Languages window appears (Figure 4). 
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Figure 4: Languages Window 
8. Select the preferred language. 

9. Click Next. The Confirm Installation window appears (Figure 5). 

 

Figure 5: Confirm Installation Window 
10. Click Next. The Installing FX CommPro N2Open window displays 

the progress of the installation (Figure 6). The Installation Complete 
window appears (Figure 7). 
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Figure 6: Installing FX CommPro N2 Window 

 

Figure 7: Installation Complete Window 
11. Click Close. 

Note: Do not rename the program directory after the program 
has been installed. 
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FX CommPro N2 Navigation 

Starting FX CommPro N2 
To start FX CommPro N2: 

1. From the Windows Start menu, select Programs > FX Tools > FX 
CommPro N2Open. The FX CommPro N2Open Window appears  
(Figure 8). 

 

Figure 8: FX CommPro N2Open Window 
2. From the Connection menu, select Open connection. 
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Figure 9: Open Connection Window 
3. Select the appropriate communication port, connection type, and 

baud rate. 

4. Click Connect. The Scan window appears (Figure 10). 

 

Figure 10: Scan Window 
5. Enter the device address or select a range of addresses to scan and 

click Scan. Once the system identifies a controller, the 
FX CommPro N2 main window appears (Figure 11). 
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Main Window 

 

Double-click on window 
headers to make the 
window full size.  

Double-click again to 
return the window to its 
original size. 

Figure 11: FX CommPro N2 Main Window 
The FX CommPro N2 main window contains the following areas: 

• Menu Bar and Toolbar - provides an interface to the available 
actions allowed for the menu item or button you select. 

• Device Window - displays the identified N2 devices, which 
includes their type and address. 

• Details Window - provides details about the selected N2 device. 

• Profile Window - lists the N2 points available to monitor, adjust, or 
command. 

• Watch Window - displays information of multiple points 
simultaneously. 

• Status Bar - displays general information about the operation of the 
tool Network View area to show connected devices and their 
network variables. 

Note: To view a window as a full size window, double-click on the 
window header. To return the window to its original size, double-click 
the window header again. 
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Menu Bar 
In the Menu Bar (Figure 12), you can click on a menu item for a list of 
corresponding options. Available options appear in black. Options not 
available appear in gray. 

 
Figure 12: Menu Bar 

File Menu 
The File menu includes the following options: 

• Load Session - opens and automatically reestablishes the session 
exactly as it was previously saved. 

• Save Session - saves the session. This includes the connection 
settings, the scanned devices, and the watch view. 

• Load watchtemplate - opens a Watch Template. The Watch 
Template provides a way for you to customize Watch Views. 

• Save watchtemplate - saves a customized Watch View to a Watch 
Template. 

Connection Menu 
Use the Connection menu to open or close the network interface 
between FX CommPro and field controllers. 

• Open connection - provides a link to the Open Connection 
window. 

In the Open Connection window, you can define and establish the 
network interface between FX CommPro N2 and an N2 network. 
You can also establish a direct connection between FX CommPro 
N2 and a single device via Point-to-Point (PPP). 

• Close connection - closes the network interface between 
FX CommPro N2 and the N2 network or the PPP connection. 

Network Menu 
Use the Network menu to identify devices on the N2 trunk. 

The Network menu includes the following options: 

• Scan - connects the FX CommPro to a specific device on the N2 
network when you identify the device N2 address. 

• AutoScan - discovers all devices on the N2 network within a 
user-identified range of N2 addresses. 
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Tools Menu 
The Tools menu provides the following options: 

• Extract Package - extracts the skin (.skc) file from the 
commissioning file (.cn2o). This is used to provide a graphical user 
interface for a standard application. See Graphic Commissioning. 

• Edit Settings - changes the network connection parameters, device 
and point polling rates, and the units of measure. 

View Menu 
Use the View menu to show or hide the Details, Device, Profile, and 
Watch windows. 
About Menu 
Use the About menu to view information about FX CommPro N2, 
including the revision. 

Toolbar 
The buttons in the toolbar (Figure 13) provide a shortcut to specific 
functions in FX CommPro N2. Table 1 shows the toolbar icons and 
describes their functions. 

 

Figure 13: Toolbar 

Table 1: Toolbar Icons 

Icon Description 

 Opens a connection. 

 
Closes the connection. 

 Scans the network for a device with a 
specified N2 address. 

 
Autoscans the network for devices 
within a specified N2 address range. 

 
Allows you to change the network 
connection parameters, device and 
point polling rates, and units of 
measure. 

 
Provides information about FX 
CommPro. 
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Device View 
The Device View shows all the devices currently connected to 
FX CommPro N2 (Figure 14). 

 

Figure 14: Device View 

Device View Right-Click Options 
You can add devices to the Device View and change how they appear 
when you right-click on an empty area in the Device View (Figure 15). 

 

Figure 15: Device View Right-Click Menu Items 
The right-click options include the following: 

• Add Devices - opens the Scan window. Use the Scan window to 
connect N2 devices by identifying their specific N2 address or a 
range of N2 addresses. 

• View - allows you to change how connected devices appear in the 
Device View. You can change the Device View so that devices 
appear as icons, tiled icons, or in a textual list. 

• Icon Dimension - allows you to change the size of the device icons 
to small, medium, or large. 

Once devices appear in the Device View, you can perform several 
actions when you right-click on the selected device (Figure 16). 

 

Figure 16: Device View Right-Click Menu Items 
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The right-click options include the following: 

• Application > Download - downloads the desired application 
software file (.apd), commissioning skin file (.skc), and design skin 
file (.skc) to the selected device(s). Only FX16 Rev. B controllers 
allow you to download the commissioning and design skin files. 

• Firmware > Download - downloads the desired firmware file 
(*.a37) to the selected device. 

• Application > Upload - uploads the desired application software 
file (*.apd), commissioning skin file (*.skc), and design skin file 
(*.skc) from the selected devices. This feature is currently only 
supported by the FX16 Rev. A and higher controllers. 

• Trends > Upload - uploads the trend log from the selected device. 
This feature is currently only supported by the FX16 Rev. A and 
higher controllers. 

• Pass-Through - establishes a Pass-Through connection to the local 
link bus, allowing you to perform operations (for example, 
application downloading, exploring, and uploading trends) on the 
target controller’s slave devices. This feature is currently only 
supported by the FX16 Rev. A and higher controllers. 

• Time Synchronization - updates the time and date of the selected 
devices to the time and date of the computer. 

• Explore Profile - populates the Profile View with a tree showing all 
the N2 profile points of the device. 

• Graphic Commissioning - allows you to explore the device N2 
points with a graphical plug-in similar to FX Builder Express. 

• Rename Device - allows you to change the name of the device. 

• Remove Selected Devices - removes the selected device from the 
Device View. 
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Profile View 
The Profile View contains a tree that shows the application N2 profile 
points inside the selected device (Figure 17). 

 

Figure 17: Profile View 

Device View Right-Click Options 
When you right-click on the device name or in an empty area of the 
Profile View (Figure 18), you can: 

• add all N2 points to the Watch View 

• remove all N2 points from Watch View 

• group points by their N2 point type (for example, adf, adi, and bd) 
or by their application point data type (for example, input, output, 
and attribute) 

 

Figure 18: Profile View Right-Click Options 
By right-clicking on the point (Figure 19), you can: 

• write to or override the point 

• add point to Watch View 

• remove point from Watch View 

 

Figure 19: Profile View Right-Click Options 
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Details View 
The Details View (Figure 20) contains detailed information about the 
device you select in the Device View or the point you select in the 
Profile View. 

 

 

Figure 20: Details View 
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Watch View 
The Watch View displays detailed information from one or more 
devices (Figure 21). The detailed point information includes: 

• Device Address 

• Long Name 

• Value 

• Point Address 

• Point Type 

• Date Type 

• Polling Rate 

 

Figure 21: Watch View 
You add points to the Watch View from the Profile View. Points in the 
Watch View appear in rows. Click on the columns to sort the points 
(click once for ascending and again for descending). 

To perform actions on one or more points, right-click on the points and 
select the desired action from the list (Figure 22). These actions 
include: 

• write to or override the point 

• remove from Watch View 

• change the poll rate 

 

Figure 22: Watch View Right-Click Options 
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Connecting to Devices 
FX CommPro N2 supports three types of connections to the field 
controller: 

• N2 Bus (Network) 
The serial port of the computer connects to the N2 network or to an 
N2-enabled controller via an RS-232 to RS-485 converter. 

• Display Remote Connection 

The serial port of the computer connects to the Medium User 
Interface (MUI) via an RS-232 to RS-485 converter. 

• PPP Direct Connection 
The serial port of the computer connects to a modem-enabled 
controller via a null modem cable. 

• PPP Dial-up Connection 
The computer connects to the modem-enabled controller via 
internal or external modem (Public Switched Telephone Network 
[PSTN]/Global System for Mobile Communications [GSM]) and 
telephone cable. 

Connecting to One or More N2 Devices 
To connect to one or more N2 devices: 

1. Connect an RS-232 to RS-485 converter to the computer serial port. 

2. Connect the N2 device or N2 trunk to the RS-485 converter  
(Figure 23). 

 

Figure 23: N2 Bus Connection 
3. Start FX CommPro N2. 
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4. Click the Open Connection toolbar icon. The Open Connection 
window appears (Figure 24). 

 
Figure 24: Open Connection Window 

5. Select the COM1 port of the connected RS-232 to RS-485 
converter. 

6. Select N2 Open Connection type. 

7. Select 9600 baud rate. 

8. Click Connect. The Scan window appears (Figure 25). 

 

Figure 25: Scan Window 
9. Enter the device address or select a range of addresses to scan. 
10. Click Scan. 

FX CommPro N2 scans for the specific N2 address or for all 
devices with the specified address range. A status bar shows the 
progress. Once the scan finishes, the main window appears. The 
Device View displays all the found devices. 
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11. To add more devices, select Scan from the Network menu (or 
Autoscan from the Network menu). 

Note: You can also right-click in the Device View, and select Add 
Devices.  

Connecting to Devices via PPP Connection 
To connect to a device using PPP connection: 

1. Using a null modem cable, connect the modem-enabled 
FX controller to the computer serial port (Figure 26). 

 

Figure 26: PPP Connection 
2. Start FX CommPro N2. 

3. Click the Open connection toolbar icon. The Open connection 
window appears (Figure 27). 

 

Figure 27: Open Connection Window 
4. Select the COM1 port of the connected null modem cable. 

5. Select Direct Connection type. 

6. Select 9600 baud rate. 

7. Click Connect. Once the system identifies the controller, the 
FX CommPro N2 main window appears with the device added to 
the Device View. 
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Connecting to Devices Using a Modem Connection 
To connect to a device using a modem connection: 

1. Connect the modem-enabled FX controller to the computer via a 
modem and telephone cable (Figure 28). 

 
Figure 28: Modem Connection 

2. Start FX CommPro N2. 

3. Click the Open connection toolbar icon. The Open connection 
window appears (Figure 29). 

 

Figure 29: Open Connection Window 
4. Select the COM1 port of the connected external modem or the port 

assigned to the internal modem. 

5. Enter the telephone number to dial. 

6. Select 9600 baud rate. 

7. Click Connect. Once the system identifies the controller, the 
FX CommPro N2 main window appears with the device added to 
the Device View. 
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Connecting to Slave Devices Using Pass-Through 
The Pass-Through feature allows you to perform operations on devices 
connected to the local link bus of the FX16 Rev. B controller. Once the 
Pass-Through connection is established, you can perform the following 
operations on the slave devices: 

• application download (supported only for slave devices defined as 
part of a gateway object)  

• application upload (supported only for FX16 Rev. B slave devices, 
which are defined as part of a gateway object) 

• time synchronization 

• explore features (read, override, and release) 

• trend upload (supported only for FX slave devices, which support 
trending) 

To connect to a slave device using Pass-Through: 

1. Establish a connection to the target master device. 

2. In the Device View, select the target master device. 

 

Figure 30: Selecting Pass-Through 
3. Right-click the selected master device (Figure 30), and select Open 

Subnet from the Pass-Through menu. The Pass-Through Mode 
Wizard appears (Figure 31).  

 



 FX Tools Software Package – FX CommPro N2 User’s Guide 24 

 
Figure 31: Pass-Through Mode Wizard 

4. Select the desired scanning mode:  

• Logical Scan – Select this option if the slave device is defined 
in the master device application (either as part of a distributed 
application or as part of a gateway object). 

• Physical Scan – Select this option to discover all the devices 
attached to the local link bus regardless of whether they are 
defined in the master device application. During a Physical 
Scan, the master controller goes into a Standby state while the 
devices on the local link are discovered. 

A status bar displays the scanning progress (Figure 32). Once the 
scan process finishes, the Pass-Through Mode Wizard identifies all 
discovered devices and their connection type (Figure 33). 
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Figure 32: Scanning Progress 

 
Figure 33: Scanned Device Results 

5. Click Next. The FX CommPro N2 main screen appears. The Device 
View displays tabs that show the original connection to the master 
device and the connection to the subnet of the master device (local 
link bus). See Figure 34. 
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Figure 34: Slave Device Added to the Device View 

6. To close the Pass-Through connection, right-click the master device 
and select Close Subnet from the Pass-Through menu. The 
Pass-Through connection closes, and the slave devices are removed 
from the Device View. 

Connecting to a Medium User Interface (MUI) 
To connect to an MUI 

1. Connect an RS-232 to RS-485 converter to the computer serial port. 

2. Connect the MUI to the RS-485 converter. 

3. Connect power to the MUI. If powering a local mount MUI from an 
FX Field Controller using the LP-KIT007-000C, disconnect the 
wires from terminals LL+ and LL- on the FX Field Controller. 

4. Start FX CommPro N2. 

5. Click Open Connection. The Open Connection window appears 
(Figure 24). 

 
Figure 35: Open Connection Window 

6. Click the appropriate COM port with the RS-232 to RS-485 adapter. 

7. Select Display Remote Connection from the drop-down menu. 

8. Click Connect. 
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Downloading Files 
Use FX CommPro to download the following types of files into the FX 
field controllers: 

• application files (*.apd) 

• firmware files (*.a37) 

In addition, you can also use FX CommPro to download the application 
source code, design skin files, and commissioning skin files to FX16 
Rev. B controllers. 

Downloading an Application File to FX Controllers  
Before you download an application to a controller, you must first 
connect FX CommPro N2 to the device. For more information, see 
Connecting to Devices. 

In FX CommPro N2, you can download a single application file to a 
device. You can also select multiple different devices and then 
download multiple applications at the same time. 

To download an application file to the FX controllers: 

1. In the Device View, select the target device. 

Note: If necessary, you can select more than one device. 

2. Right-click the selected device (Figure 36), and select Download 
from the Application menu. The Download Operation Status 
window appears (Figure 37). 

 

Figure 36: Selecting Application Download 
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Click to sort 
on the 
device 
address. 

Select the 
application 
(.apd) file for 
each controller. 

Figure 37: Download Operation Status Window 
3. Click the browse button in the Application File column for the 

desired controller, and select the application (.apd) file. 

Note: 

Note: 

You can use Ctrl or Shift to select two of the same 
controllers and then select an application file for both controllers. 
The same application then appears for both devices. 

If you select an application that is not compatible to the device you 
selected, a message appears in the Notes column saying Device not 
Compatible. If necessary, right-click on the device with the 
incompatible application and select Clear File or Remove Device. 

If you remove a device, then you need to go back to the 
main screen to add it again. 

4. Click Start. The download process starts. 

The Download Operation Status window displays the progress of 
each application download operation. When the download operation 
finishes, a Download Completed message appears. 

 

Figure 38: Download Operation Progress 
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5. Click OK to exit the Download Operation Status window  
(Figure 38). 

Note: For dial-up connections, the controller restarts after the 
completion of the application download. This reboot operation takes 
up to 2 minutes. At this stage, the dial-up connection ends. 
FX CommPro N2 closes the dial-up connection session and does 
not automatically reconnect the controller. You must open another 
session. 
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Downloading a Firmware File to FX Controllers 
Before you download a firmware file to a controller, you must first 
connect FX CommPro N2 to the device. For more information see 
Connecting to Devices. 

To download a firmware file to an FX controller: 

1. In the Network View, right-click the desired device and select 
Download from the Firmware menu (Figure 39). The Select 
Firmware Files to Download window appears (Figure 40). 

 

Figure 39: Select Firmware>Download 

 

Figure 40: Select Firmware Files to Download Window 
2. Click the  button. The Open dialog box appears. 

3. Select the desired firmware file and click Open. Click Next. The 
Download Firmware Operation Status dialog box appears  
(Figure 41). 
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Figure 41: Download Firmware Operation Status Window 
4. Click Start. The download process starts. 

The Download Firmware Operation Status window displays the 
progress of the firmware download operation. When the download 
operation finishes, the Progress cell displays a Download 
Completed message. 

IMPORTANT:  Take all precautions to prevent a power interruption or a 
communication interruption between FX CommPro N2 and the target 
controller during a firmware download. An interrupted firmware download may 
cause the controller to become permanently unresponsive. 

5. Click OK. 
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Downloading Application and Skin Files to FX16 Rev. A and Higher 
Controllers 

FX16 Rev. A and higher devices allow you to download application 
files (.apd). These devices also allow you to download, design, and 
commission skin files (.skc), which enable you to upload the design and 
commissioning skin files at a later date, if needed. 

Design Skin File 
An uploaded design skin file allows you to view and edit the actual 
configuration using FX Builder Express. 

Commissioning Skin File 
An uploaded commissioning skin file allows you to use the 
FX CommPro commissioning plug-in feature. 

Before you download these files to an FX16 Rev. A and higher 
controller, you must first connect FX CommPro N2 to the device. For 
more information, see Connecting to Devices. 

To download application and skin files to the FX16 Rev. A and higher 
controllers: 

1. In the Device View, select the target device. 

Note: If necessary, you can select more than one target device. 

 

Figure 42: Selecting Application Download 
2. Right-click the selected device, and select Download from the 

Application menu (Figure 42). The Select files to download window 
appears (Figure 43). 
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Figure 43: Selecting the Application File to Download 
3. Click the  icon next to Application. The Open window appears. 

4. Select the desired application file (.apd), and click Open. The Select 
files to download window reappears (Figure 44). 

5. If necessary, repeat Steps 3 and 4 to select Commissioning Skin and 
Design Skin files. 

 

Figure 44: Files Selected for Downloaded 
6. Click Next. The Download Operation Status window appears 

(Figure 45). 

 

Figure 45: Download Operation Status Window 

 



 FX Tools Software Package – FX CommPro N2 User’s Guide 34 

7. Click Start. The download process starts. 

The Download Operation Status window displays the progress of 
the application download (Figure 46). When the download 
operation finishes, the Progress cell displays a Download 
Completed message. 

 

Figure 46: Download Operation Progress 
8.  Click OK. 

Note: For dial-up connections, the controller restarts after the 
completion of the application download. This reboot operation takes 
up to 2 minutes. At this stage, the dial-up connection ends. 
FX CommPro N2 closes the dial-up connection session and does 
not automatically reconnect the controller. You must open another 
session. 
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Downloading Firmware File to Medium User Interface  
To download a firmware file to an MUI: 

1. Click the Open Connection toolbar icon. The Open Connection 
window appears. 

2. Check the circle for the appropriate COM port with the RS-232 to 
RS-485 adapter. 

3. Select Display Remote Connection from the drop-down menu. 

4. Click Connect. The Display Devices Firmware Update dialog box 
appears. 

 
Figure 47: Select MUI Version 

5. Select the appropriate version of MUI. 

6. Click Browse. The Open dialog box appears. 

7. Select the desired MUI firmware file (Figure 48). 

 
Figure 48: Browse to Firmware File 
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8. Click Open. The Display Devices Firmware dialog box reappears. 

9. Click Next. The progress window appears. 

10. Click Start (Figure 49). The firmware download progress window 
shows current status. 

 

 
Figure 49: MUI Firmware Download Progress 

11. Once the MUI firmware download finishes, click OK. 

 



 FX Tools Software Package – FX CommPro N2 User’s Guide 37

Uploading Files from FX Field Controllers 
Use FX CommPro N2 to upload application, design skins, and 
commissioning skin files and trends from FX16 Rev A controllers. 

Uploading Application, Design Skin, and Commissioning Skin Files 
from FX16 Rev. A and Higher Controllers 

Before you upload files from an FX16 Rev. A and higher controller, 
you must first connect FX CommPro N2 to the device. For more 
information, see Connecting to Devices. 

To upload application, design skin, and commissioning skin files from 
FX16 Rev. A and higher controllers: 

1. In the Device View, select the target device. 

Note: If necessary, you can select more than one target device. 

 

Figure 50: Selecting Application Upload 
2. Right-click the selected device, and select Upload from the 

Application menu (Figure 50). The Select files to upload window 
appears (Figure 51). 

 

Figure 51: Select Files to Upload 
3. Click the  icon next to Application. The Save As window 

appears. 
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4. Select the application file (.apd) to save, and click Save. The Select 
files to upload window reappears (Figure 52). 

 

Figure 52: Files Selected for Uploading 
5. If necessary, repeat Steps 3 and 4 to select the locations for the 

commissioning skin and design skin files. 

6. Click Next. The Upload Operation Status window appears  
(Figure 53). 

 

Figure 53: Upload Operation Status Window 
7. Click Start. The upload process starts. 

The Upload Operation Status window displays the progress of the 
application upload operation (Figure 54). When the upload 
operation finishes, an Upload Completed message appears. 
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Figure 54: Upload Operation Progress 
8. Click OK. 

Uploading Trends from FX16 Rev. A and Higher Controllers 
Before you upload trends from the FX16 Rev. A and higher controller, 
you must first connect FX CommPro N2 to the device. For more 
information, see Connecting to Devices. 

To upload trends from FX16 Rev. A and higher controller: 

1. In the Device View, select the target device. 

 

Figure 55: Uploading Trends 
2. Right-click on the selected device, and select Upload from the 

Trends menu (Figure 55). The Trend Upload Wizard appears  
(Figure 56). 
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Figure 56: Trend Upload Wizard 

3. Enter the target folder name or click on the  icon, and select 
the target folder (Figure 57). 

 

Figure 57: Browse for Folder 
4. Click OK. The Trend Upload Wizard appears (Figure 58). 

The wizard allows you to check or clear the trend buffer. You can 
also reselect the target folder. 

 



 FX Tools Software Package – FX CommPro N2 User’s Guide 41

 

Figure 58: Trend Upload Options 
5. Select the desired options, and click Finish. The Upload Operation 

Status window appears (Figure 59). 

 

Figure 59: Upload Operation Status Window 
6. Click Start. The Upload process starts. 

The Upload Operation Status window displays the progress of the 
application upload operation. When the upload operation finishes, 
an Upload Completed message appears. 

7. Click OK. 
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Commissioning Controllers 
Commissioning is a set of processes you use to ensure the controller 
works as expected. FX CommPro N2 allows you to perform the 
following commissioning activities: 

• monitoring N2 points 

• overriding N2 points 

• adjusting N2 points 

Before you commission controllers, you must first connect 
FX CommPro N2 to the device. For more information, see 
Connecting to Devices. 

Exploring the Device 
To commission a controller with FX CommPro N2, you need to first 
explore the N2 network profile of the device. The N2 network profile 
contains all of the points exposed to the N2 network. The N2 network 
profile is defined when the application software is configured with FX 
Builder or FX Builder Express. If you want FX CommPro N2 to 
explore the points inside the FX controller, the controller must contain 
an application with a predefined N2 network profile. 

After an application downloads to a controller, the Profile View 
populates with the N2 network profile points. 

To explore a device: 

1. In the Device View, right-click on the target device and select 
Explore Profile (Figure 60). The Open Window appears. 

 

Figure 60: Exploring the Profile 
2. Select the application file (.apd) currently loaded in the target 

controller, and click Open. 

The Profile View is populated with the points defined in the N2 
network profile (Figure 61). FX CommPro N2 groups points by 
their N2 Point Type or by their application point data type. 
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Figure 61: Profile View (Grouped by Point Type) 
3. To change the grouping, right-click on any area in the Profile View, 

and select Group By (Figure 62). 

 

Figure 62: Changing the Grouping 
4. Select the desired group type: Point Type or Data Type. The Profile 

View displays the points grouped by the selected type. 
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Viewing Point Details Using the Profile View 
To view point details using the Profile View, click on the desired point 
in the Profile View (Figure 63). 

Information about the selected point appears in the Details View. This 
method is a quick way to view point information; however, you can 
only view information about one point at a time. 

 

Figure 63: Viewing a Point Value in the Details View 
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Viewing Point Details Using the Watch View 
You can also add a desired point to the Watch View (Figure 64). 

The Watch View can contain multiple points and can originate from 
different connected devices. The Watch View contains a table that 
allows you to sort points by the following attributes: 

• Device Address 

• Long Name 

• Value 

• Point Address 

• Point Type 

• Data Type 

• Polling Rate 

The Watch View allows you to easily compare the values of multiple 
points. 

 

Figure 64: Viewing Points in the Watch View 

Adding a Specific Point to the Watch View 
To add a specific point to the Watch View, right-click the point and 
select Add to Watch View. 

Adding All Points in the Profile to the Watch View 
To add all the points in the profile to the Watch View, right-click on 
an empty area of the Profile View, and select Add all N2 Point to 
the Watch View. 
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Overriding Points 
To override a point: 

1. Right-click the point (either in the Profile View or the Watch 
View), and select Override (Figure 65). The Edit Value window 
appears (Figure 66). 

 

Figure 65: Overriding a Point from the Watch View 

 

Figure 66: Edit Value Window 
2. Enter the desired override value, and click OK. 
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Defining a Watch Template 
You can define a Watch Template to customize the Watch View with 
specific point information. Once you create a Watch Template, you can 
assign it to one or more devices. This event allows you to easily 
compare similar points sourced from different devices. 

To define a Watch Template: 

1. In the Network View, right-click the device and select Define 
Template from the Watch Template menu (Figure 67). 

 

Figure 67: Define Watch Template 
2. From the Profile View, drag the points to the Watch View. 

3. On the File menu, click Save Watch Template. 

4. Enter the name of the template and click Save. 

Applying a Watch Template to a Device 
Once you customize the Watch View, you can assign the defined 
template to another device. Defining Watch templates and then 
assigning the template to other devices allow you to easily compare 
different points to each other. 

To apply a watch template to a device: 

1. With the Watch Template you want to apply already open, right-
click the desired device in the Network View. 

2. Select Apply Template from the Watch Template menu (Figure 68). 
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Figure 68: Apply Watch Template 

Exporting Watch View Data 
You can export Watch View data to a Microsoft® Excel (.xls) format. 

To export Watch View data: 

1. Right-click in the Watch View template. 

2. Select Export device watch data (Figure 69). Microsoft Excel opens 
and displays the data you exported. 

 

Figure 69: Exporting Watch Data 
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Graphic Commissioning 
Use graphic commissioning for standard applications configured using 
FX Builder Express. Graphic commissioning provides similar functions 
as standard commissioning, except that the points appear in a graphical 
plug-in (similar in appearance to the FX Builder Express plug-in). 

Extracting the Skin File from the Commissioning Package 
Each standard application includes a commissioning package file 
(.cn2o). This zipped file contains the commissioning skin file (.skc), 
which invokes the graphical commissioning session for that specific 
application. 

To extract the skin file from the commissioning package, select Extract 
Package from the Tools menu (Figure 70). 

 

Figure 70: Extracting the Commissioning Skin File 

Invoking Graphic Commissioning 
To invoke Graphic Commissioning:  

1. Right-click the device from the Device View, and select Graphic 
Commissioning (Figure 71). The Open window appears. 

 

Figure 71: Invoking Graphic Commissioning 
2. Select the commissioning skin file that corresponds to the 

application loaded in the selected controller, and click Open. 

The commissioning plug-in appears and presents real-time 
information in a graphical plug-in (Figure 72). The commissioning 
plug-in is similar in appearance to the FX Builder Express 
application configuration plug-in, except that it includes folders for 
the Hardware (location of the input and output values) and for the 
various sequence of operation states. 
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Figure 72: Graphic Commissioning 

Performing a VAV Box Flow Test 
The Variable Air Volume (VAV) Box Flow Test is a feature available 
only for those controllers containing the Box Flow Test object in their 
application software. Currently, this object is only available in the 
FXVMA. 

Use the VAV Box Flow Test to verify and diagnose the operations of 
the FXVMA controller when attached to a VAV box. When the VAV 
Box Flow Test is initiated, FXVMA opens (or closes, depending on the 
user-defined setting) the VAV box damper, pausing at user-defined 
steps. The FXVMA pauses momentarily at each step, takes a flow 
reading, and continues. Once the cycle is complete, the Box Flow Test 
evaluates all the flow readings and provides you with a diagnostic 
report that you can view and also export to a text (*.txt) file. 

To perform a VAV Box Flow Test: 

1. Connect FX CommPro to the network of FXVMAs. 

2. Select the target FXVMA and click on Box Flow Text from the 
Tools menu (Figure 73). The FXVMA Box Flow Test Wizard 
appears (Figure 74). 

 
Figure 73: Select Tools > Box Flow Test 
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Figure 74: FXVMA Box Flow Test 
3. Click Next. Step 1 of the Box Flow Test Wizard appears  

(Figure 75).  

4. Select all the desired FXVMA controllers on which to perform the 
test. 

 

Figure 75: Device Selection 
5. Click Next. Step 2 of the Box Flow Test Wizard appears  

(Figure 76). 

6. Use the list box to select the starting position for each FXVMA. 

If you perform the test on multiple FXVMAs, we recommend you 
select the Alternate starting position button. When you select this 
button, the starting positions for all the FXVMAs are staggered. 
This prevents the VAV box dampers from all being closed at the 
same time, which in turn prevents an excessive buildup of pressure 
in the supply duct. 
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Figure 76: Set Starting Positions 
7. Click Next. Step 3 of the Box Flow Test Wizard appears. Set the 

following test characteristics: 

• Test type: Set to either One way or Two way. Setting to One 
way modulates the damper in only one direction (for example, 
from open to closed or from closed to open). Setting to Two 
way modulates the damper in both directions (for example, from 
open to closed and back to open). 

• Test steps: Select a number between 2 and 10. The test divides 
the stroke time by the number of steps, pauses at each of these 
intervals, and takes a flow reading. 

• Test stroke time: Enter the desired stroke time. The FXVMA’s 
internal actuator is a 60-second actuator, so you typically leave 
this setting at its default value (60 seconds). 

8. Click Next. Step 4 of the Box Flow Test Wizard appears  
(Figure 77). The FXVMA executes the test. 

The FXVMA actuator cycles according to the test characteristics 
you defined, and takes flow readings at each interval. A progress 
bar and status window provides you with the estimated time to 
complete the test and the current operation. 
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Figure 77: Executing Test 
When you finish, a message indicates that the test is complete. 

9. Click OK. 

10. Click Next. Step 5 of the Box Flow Test wizard appears  
(Figure 78). This dialog box shows the results of the Box Flow Test 
for each FXVMA, including the following: 
• device name and address 
• actual flow readings at the defined steps 
• VAV box rated flow 
• status, which shows the summary of the status of the current or 

most recent test. 
• Error Summary. See Table 2. 

 
Figure 78: FXVMA Plug-in 
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Table 2: Error Summary 
Error Summary cription   Des
Large dP Offset f the absolute value of the Delta P Offset is 

 equal to the Delta P Offset tolerance. 
This indicates that an auto calibration was performed 

he damper was not fu
m of a stuck or rever

Occurs i
greater than or

when t
sympto

lly closed. This is often a 
sed actuator. 

Flow Not Reliable Occurs if the flow sensor analog input is not reliable. 
Damper 
Command Not 
Responding 

Occurs if the damper positio
commanded value for one o

n did not reach its 
r more of the test steps. 

Poor Flow 
Response 

Occurs if (Max Flow – Min F
olerance/100). The flo
tly 0%. 

low) <= (RatedBoxFlow * 
w tolerance is Flow T

curren
Insufficient Flow rs if Max Flow < 

oxFlow*100-FlowTo
 Occu

(RatedB lerance/100) 
Excessive Flow f Max Flow > 1.5 * ROccurs i atedBoxFlow 
Non-increasing 
Flow 

f flow change is moving in the wrong 
direction (depending on if damper is opening or 

 

Occurs i

closing)
Excessive 
Hysteresis 

if flow reading at a s
direction is significantly differ
at the same step in the closi

w tolerance). 

Occurs tep in the opening 
ent than the flow reading 

ng direction (percent 
error > flo

 

11. Click Save t ve the test result

12. Select the de  location. Click OK. 

13. Click Finish  window of FX C

o file to sa s to a *.txt file. 

sired

. The main ommPro N2 reappears. 
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Saving a Session 
When you save the session you save the connection settings, the 
devices that were scanned, and the watch view.  

To save the session: 

1.  From the File menu, click Save Session. The Save session to file 
screen appears (Figure 79). 

 

Figure 79: Save Session to File 
2. Enter the name of the file and click Save. 

Loading a Session 
Use the Load Session feature to open a previously saved session. 

To load a session: 

1. From the File menu, click Load Session. 

2. Select the session you want to load and click Open. FX CommPro 
N2 opens the previously saved session.  
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Specifications and Technical Data 

Ordering Codes 
Table 3: Software 
Product Code Product Description 
LP-FXTPRO-0 FX Tools Pro CD ROM (FX Builder, FX Builder Express, FX CommPro N2, FX CommPro 

LON, FX CommPro BACnet® software, FX Loader and MD LON Loader) - New User 
LP-FXTPRO-6 FX Tools Pro CD ROM (FX Builder, FX Builder Express, FX CommPro N2, FX CommPro 

LON, FX CommPro BACnet, FX Loader, and MD LON Loader) - upgrade 

 

Technical Specifications 
Table 4: FX CommPro N2 Tool 

System Requirements 
Operating System Microsoft Windows 2000 (with Service Pack 4 or later) 

Microsoft Windows XP® (with Service Pack 2 or later) 
Processor Intel® Pentium® Processor, 500 MHz or higher 
RAM Minimum 512 MB RAM (1 GB recommended) 
Hard Disk 60 MB available hard disk storage 

2.5 MB (typical) to 6 MB (maximum) for each application file 
Display Display resolution 800 x 600 16-bit (32,768) color minimum 

Hardware 
Requirements 

Communication 
Interface 

RS-232C, USB 

Software Requirements Microsoft .NET Framework Version 2.0 

The performance specifications are nominal and conform to acceptable industry standards. For application at conditions beyond 
these specifications, consult the local Johnson Controls ® office. Johnson Controls, Inc. shall not be liable for damages resulting 
from misapplication or misuse of its products. 

 

 

Building Efficiency 
507 E. Michigan Street, Milwaukee, WI  53202 

 
Metasys® and Johnson Controls® are registered trademarks of Johnson Controls, Inc. 

All other marks herein are the marks of their respective owners. © 2008 Johnson Controls, Inc. 
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